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Notice

Information contained in this document is believed to be accurate and reliable at the time
of printing. However, due to ongoing product improvements and revisions, AudioCodes
cannot guarantee accuracy of printed material after the Date Published nor can it accept
responsibility for errors or omissions. Updates to this document can be downloaded
from https://www.audiocodes.com/library/technical-documents.

This document is subject to change without notice.
Date Published: April-14-2021

WEEE EU Directive

Pursuant to the WEEE EU Directive, electronic and electrical waste must not be disposed of with
unsorted waste. Please contact your local recycling authority for disposal of this product.

Customer Support

Customer technical support and services are provided by AudioCodes or by an authorized
AudioCodes Service Partner. For more information on how to buy technical support for
AudioCodes products and for contact information, please visit our website at
https://www.audiocodes.com/services-support/maintenance-and-support.

Documentation Feedback

AudioCodes continually strives to produce high quality documentation. If you have any
comments (suggestions or errors) regarding this document, please fill out the Documentation
Feedback form on our website at https://online.audiocodes.com/documentation-feedback.

Stay in the Loop with AudioCodes
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1 Introduction

Voca provides a state-of-the-art voice recognition service for enterprises, enhancing day-to-day
customer interface and employee productivity by making organizational contacts easily
accessible from multiple user environments by voice.

Combining powerful speech recognition engine with a simple-to-use conversational interface,
Voca introduces a reliable, 24x7 call routing solution that reduces costs, increases the
employee's  productivity and enhances caller experience and  satisfaction.
Voca easily integrates with any standard PBX based on analog, digital and IP network protocols
and can be deployed as a secured cloud service or On-premises.



CHAPTER 2  Getting Started Voca | Installation Manual

2 Getting Started

There are a number of ways to install the Voca system:

B Clean Windows Installation: A customer provides a clean-installed Windows 2016 system
with the latest security updates. The installation will be provided by AudioCodes as a
downloadable URL.

B AudioCodes Mediant 800 Installation: AudioCodes provides a Mediant 800 with a pre-
installed Windows 2016. The installation package will be located at C:\ACVoca_Installer.

B Pre-installed: AudioCodes offers Voca Software as a Service (SaaS) as a cloud deployment.
Please contact your AudioCodes representative for more information on this option.

The default Administrator's password is "Pass123". It is highly recommended to
change the password according to the Enterprise's policy. The updated password
must be stored in a secure location, so that it is accessible to those that need to it.

The installer does not currently support the Voca GMM ASR engine (under
development).

Hardware Requirements and System Capacities

The following describes the hardware requirements and system capacities.
Hardware Requirements

On-premises Installation

The Voca server requires the following minimum hardware configuration (not including SBC):

B CPU: Intel Core i7-5th Gen @ 2.7GHz with eight cores or higher (HyperThreaded cores can
be counted). The processor must at least support AVX2 and FMA features.

B RAM:32GB

SSD: 256 GB

B NIC: 1GB Ethernet card with static MAC address (For Hyper-V installations, configure the
MAC address using the Advanced Features option.)

B Operating System: Windows Server 2016

Private Cloud Installations

The Voca server requires the following minimum hardware configuration:
B For AWS: Use c5.2xlarge instances or higher

B For other configurations: Contact your AudioCodes representative
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Self-installation is designed to support single-tenant deployments. For multi-tenant deploy-
ments, please contact your AudioCodes Sales or Technical Support representative.

System Capacities

The Voca server supports the following channel capacities:

B For On-premises implementations with On-premises hardware or Virtual Machine (VM)
configurations:

e 20 concurrent ASR sessions for English US
® 16 concurrent ASR sessions for German
e 20 concurrent ASR sessions for Spanish
e 20 concurrent ASR sessions for Hebrew
B For Cloud implementations:
e 30 concurrent ASR sessions for English US
® 20 concurrent ASR sessions for German
e 30 concurrent ASR sessions for Spanish
e 30 concurrent ASR sessions for Hebrew

® 50 concurrent sessions for English UK (via Microsoft Azure Cognitive Services)

Entries Support

B Up to 20,000 entries

Using Clean Windows Installation

It is the customer’s responsibility to provide a clean-installed licensed Windows 2016 system
with the following requirements:

B .NET Framework Features 3.5

If the server has Internet connectivity during installation, the framework will be
installed automatically. Otherwise .NET 3.5 should be pre-installed (see Enabling
.NET Framework 3.5 on Windows on page 47).

Disabled Virtual Memory paging file
Latest security updates

Static IP address

Disk Partitioning
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A The hard disk should be partitioned to the C:\ and D:\ drives.

B Chrome or Microsoft Edge (chromium-based)

Additional Software Installation

The user must not install any additional software on the server, including anti-virus or any real-
time scanner. Installation of any third-party software may lead to performance issues, stability
problems and may cause unpredictable results.

Disabling Virtual Memory Paging File

The procedure below describes how to disable the Virtual Memory Paging file.

> To disable Virtual Memory Paging File on a Windows System
1. Pressthe Windows key and open Control Panel.

2. Navigate to System and Security > System, and then click Advanced system settings in the
left pane.

E Systermn

A E » Control Panel » Systern and Security » System

Control Panel Home . - .
View basic information about your computer

G Device Manager Windows edition
% Remote settings Windows Server 2016 Standard
GI Advanced system settings I © 2016 Microsoft Corporation. All rights reserved.
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3. Inthe System Properties dialog box, click the Advanced tab, and then click Settings...
under the 'Performance’ group.

System Properties et

Computer Name  Hardware Advanced  Femote

“fou must be logged on as an Administrator to make most of these changes.

Performance

Visual effects, processor scheduling, memarny usage, and virtual memony

Ilzer Profiles
Desltop settings related to your sign-n

Settings...
Startup and Recoveny
System startup, system failure, and debugging information
Settings...
Environment Variables...
0K Cancel Apphy

4. Click the Advanced tab, and then click the Change... button.
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Performance Options >
Visual Effects  Advanced Dats Execution Prevention

Processor scheduling

Choose how to allocate processor resources,

Adjust for best performance of:

() Programs (®) Background services

Virtual memory

A paging file is an area on the hard disk that Windows uses as if it
were RAM.

Total paging file size for all drives: oMEB

Change...

Cancel Apply

5. Clear the 'Automatically manage paging file size for all drives' check box.

6. Select the drive that it is on, and then click the No paging file option.



CHAPTER 2  Getting Started Voca | Installation Manual

Virtual Memory *

[] Automatically manage paging file size for all drives

Paging file size for each drive

Drive [Volume Label] Paging File Size (MB])
0 [Drata] Mone
Selected drive: C:

Space available: 53593 ME

() Custom size:

[nitial size (RED:
kaxirmum size (hAB):

() Systern managed size
(®) No paging file Set

Total paging file size for all drives
Minimum allowed: 16 MB
Recommended: 4591 MB
Currently allocated: 4364 ME

QK Cancel

7. Click Set, and then click OK.

8. Select Restart Now to apply the changes.

Using AudioCodes Mediant 800 Installation

Before installing the Voca system on AudioCodes Mediant 800, do the following:
M Install Windows 2016 Security Updates
B Configure the OSN IP address

B Configure the Server System Time Settings

Installing Windows Security Updates

Install Windows Security Updates to run the latest service patches and install all missing
updates.
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Configuring the OSN IP Address
The Voca system must have a static IP address. You can configure a static IP address for the

OSN server on the Mediant 800.

If you are connected remotely, performing this step will disconnect you from the
system. After performing this step, you can re-connect the system with its new
location and IP address.

> To configure a static IP address for OSN:

1. Pressthe Windows Start key.

Expand ~

Most used #- g E

Windows
Google Chrome Administrativ... Task Manager Contrel Panel

Command Prompt
® 0 2

Conscle Event Viewer File Explorer

Motepad

Snipping Tool

Acapela Group
Mew

Enghouse Interactive

m 8 M

2. Open the Network and Sharing Center (Control Panel > Network and Internet > Network
and Sharing Center).
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L& Network and Sharing Center

T |¥ Control Panel\Network and Internet\Network and Sharing Center|

View your basic network information and set up connections
Control Panel Home

View your active networks
Change adapter settings
Change advanced sharing Network Access type: Internet
settings Private network Connections: 1 Ethernetd

Change your networking settings

ﬁ. Set up 2 new connection or network
Set up 2 broadband, dial-up, or VPN connection; or set up a router or access paint.

@ Troubleshoot problems
Diagnese and repair network problems, or get troubleshooting information.

3. Right-click the Intel(R) Ethernet Connection 1217-LM network connection, and then from
the shortcut menu, select Rename.

@ Metwerk Connections

L @ » Control Panel » MNetwork and Internet » Metwork Connections

Organize »

Name Status Device Mame

JE] Ethernet Metwerk cable unplugged Intel(R) 82574L Gigabit Metwork Connection
Ethernet 2 MNetwork cable unplugged Intel(R) 825741 Gigabit Metwork Connection #2

@ Ethernet 3 Metwork Intel(R) Ethernet Connection [217-LM I

4. Assign the new alias name as Internal.

@ Metwork Connections

T @ » Control Panel » Metwork and Internet » Metwork Connections » v O
Organize «
~
Mame Status Device Mame Connectivity
JH] Ethernet Metwork cable unplugged Intel(R) 82574L Gigabit Metwork Connection
,E.l Ethernet 2 Metwork cable unplugged Intel(R) 82574L Gigabit Network Connection #2
@ Internal Metwork Intel(R) Ethernet Connection 1217-LM Internet access

5. Right-click the Internal network connection, and then from the shortcut menu, choose
Properties.
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6.

] Internal Properties
Metworking  Sharing

Connect using:

& Intel(R) Ethemet Connection 1217-LM

This connection uses the following tems:

&3 Client for Microsoft Networks

i? File: and Printer Sharing for Microsoft Netwarks
005 Packet Scheduler

[l Intemet Protocol Version 4 (TCP/IPvd)
O 4 Microsoft Metwork Adapter Multiplexor Protocal
4 Microsoft LLDP Protocol Driver

4 Intemet Protocol Version & (TCP/IPvE)
£

>

Install... Uningtall Properties
Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected netwarks.

QK Cancel

Double-click Internet Protocol Version 4 (TCP/IPv4).

-10 -
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7. Enter the IP address and DNS server addresses.

8. Click Advanced.
Internet Protocol Version 4 (TCP/1Pv4) Properties >
General

You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask yvour network administrator
for the appropriate IP settings,

() Obtain an IP address automatically
(@) Use the following IP address:

IP address: | 10.31. 5 .250 |
Subnet mask: | 255.255. 0 . 0 |
Default gateway: | mw .31 .0 .1 |

Obtain DMS server address automatically

(®) Use the following DNS server addresses:

Preferred DMS server; | w. 1.1 .1 |

Alternate DMS server: | m. 1.1 .10 |

[ validate settings upon exit advanced. ..

Corcel

9. Clear the 'Automatic Metric' check box, and then in the 'Interface Metric' field enter "1".

-11 -
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Achvanced TCP/IP Settings >

IP Settings  DNS WINS

IF addresses

IF address Subniet mask
10.31.5.250 255,255.0,0
Add... Edit... Remove
Default gateways:
Gateway Metric
10.31.0.1 Automatic
Add... Edit... Remaove
[ ] Automatic metric

Interface metric:

Cancel

A low metric number indicates higher priority. A high metric number indicates low
priority.

10. Click OK to apply the configuration.

-12-
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] Internal Properties
Metworking  Sharing

Connect using:

& Intel(R) Ethemet Connection 1217-LM

This connection uses the following tems:

i? File: and Printer Sharing for Microsoft Netwarks
005 Packet Scheduler
[l Intemet Protocol Version 4 (TCP/IPvd)
O 4 Microsoft Metwork Adapter Multiplexor Protocal
4 Microsoft LLDP Protocol Driver

&3 Client for Microsoft Networks ”

4 Intemet Protocol Version & (TCP/IPvE) W
£ >

Install... Uningtall Properties
Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected netwarks.

QK Cancel

-13 -
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11. Click OK to close the Internal Properties window.

12. Close the Network Connections window.

-14 -
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3

Installing Voca

The procedure below describes how to install Voca. As noted in Getting Started on page 2,
there are a number of ways to install the Voca system.

Copy the installation files to the C:\ACVoca_Installer directory.

V] s | ACVoca_lnstaller

€ o v

s Quick access
B Desktop
< Downloads
“| Documents

= Pictures

Share

View

> This PC » Local Disk (C:) » ACVoca_lnstaller »

LR TR T

o

Mame

o

Acapela
Acapelaks
Voca_8.0_MSI_Edit
Voca_Backup_All
ACVoca

A restart may be required during installation. After the restart has completed, log in to
the server and the installation process will continue automatically.

To run pre-installation in case of upgrade:

1. Upgrading to Version 8.0.1 or later requires a new Voca license. Send the license Key ID
number to AudioCodes (See the To install the Voca License after upgrade procedure, in the
Installing the Voca License on page 29).

2. Backup the recent systems data.

a. The backup procedure will be performed automatically by the Voca installer. The
backup directory is C:\NSC\Backup_<Time Stamp>\BackupFiles\.

b. Itis highly recommended to save the:

+ licenses files in C:\NSC\License\ directory

& SBC configuration files in C:\NSC\SBCconfig directory

These and other important Voca directories will be backed up during the upgrade or
during the daily scheduler backup procedure.

3. Change the Enghouse services Startup Type to "Manual".

-15-
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Ck Encrypting File System (EFS) Provides th.. Manusl (Trig... Local Syste..
1£ Enghouse Interactive Alarm Center Provides am.. Running Manual Local Syste..,
&' Enghouse Interactive CTI Connect Server Telephony ¢... Running  Manual AVoca
& Enghouse Interactive Enterprise Communications Server  Manages all... Running  Manual MVeca
'{;?':Enghuuse Interactive Media Gateway Provides cal.. Running Manual AVoca
s Enterprise App Management Service Enables ent... Manual Local Syste...

4. If the LDAP standalone synchronization feature is used:
a. Un-install the old VocaEnterpriseDirectoryService.
b. Open the VocaNOM Directory Client
C:\NSC\LDAP\VocaldapService\VocalLdapSetup.exe.
c. Click Stop service.
d. Click Configure.
n VocaNOM Directery Client - Configurator/Monitor — x
Activity for last 24 Hours Listening
Cloze Minimize Configure Start/Restart Service Stop Service
e. Click Configure.
f. Click Uninstall Service.

Directory Impert Configurations *
Corfiguration Mame Schedule Enabled
AUDC_HE-IL At 11:26 PM, every day True

Add... Edit... Delete Impart Now! Uninstall Service

g. Close the VocaNom Directory Client.

h.

Rename the 'C:\ProgramData\VocaldapService\Settings.xml' file

to 'settings_bak.xml'.

-16 -
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5. If the CSV synchronization feature is used:
a. Backup CSV synchronization files located under C:\NSC\LDAP\Import_CSV_to_Cloud
b. Restore the feature after the upgrade.

6. Restart the server.

> Toinstall Voca:

1. The Windows Update service should be stopped and disabled during the Voca installation.
It can be enabled once the Voca installation procedure has been completed.

4 Seeai - o L

Fils Adien ‘View Hap

o mESass Bmlvrennw

0 Sttt Ml || hiarme ’ Dancripticn Gt Metep g LogBnds A
T The piole aAd. . Pt ol Ll Saie
Ly Wiy Pl Waruirens Fatagll L T Ll i
Gy W Foost Coche Sarvaitt  Optavints perform. Fefrers  datimast Ll Serine
L W Ietdgph L o won. | Pofronlbs i an Rpgal Linial Srane
L Wit WPl Tebtnl ] Mlirnal Listal e
2 Wt Lol B, e, b [LE] Ll Fyme
o Wit Lot Bt Gt Paroabts woliiitoast Mirvgal Tag.  Liwal Sovaie
W Manpgerianl eitns Paroedi g e Patieng St Liwsl e
il W Mk et Save P Lot el Wil (Tag Lol Sovvine
Wit Mathts el Ensbies weililptie.,  Rerwing Ml Lol e
y Wendarart Poriestitens Fourals . Oiptwvair parloem Mprnal Ll Sorin
ey Push Mo fees § Thel sedaie surn | Rofrrg  Suleempte) Lesial e
Wi Puth Mdsiatioas U T sitice Badti (L] Lewal Syite
Ly wendaran Bomcte Blpange—e  Wersdoos Berectr | Bureerg buteste it §
ey Sk Frozede £ erferd s Dabled Lessl Gyme
T Wit Tarrst Wit date pa.  Barriry  Subtmate (T Lecsl Sovior
TR Vo Prany Suma-Dri. WenHTTP mgltrn.  Rerversy Mgl Lesel Toritn
0 Wwedd Aol oty T Wared! Sutols [T Lessl Ty
2, WA Parferrrance Sdastes Paoude parforrma. Mgt Lol e o
" Reberaded ), Starcdad

2. Right-click the ACVoca installation file, and then select Run as Administrator.

| = | Application Tools AlVoca_lns
Home Share View Manage
“— v » ThisPC » Local Disk (C) » ACVoca_lnstaller
Mame
3 Quick access
Acapela
I Deskto -
3 Acapelaks
¥ Downloads ~ # Voca_8.0_MSI_Edit
Documents * Vioca_Backup_All
[&] Pictures - [ ACVe--
Open
E This PC

$ Run as administrator

3. After launching the installer, the installer Ul appears. You need to configure the installation
process.

QX audiocodes

-17 -
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4. The End user license agreement appears; click Next.

Voca X

Voca

End user license agreement .
Voca v8.0.1 End user license agreement
Select features

Language selection -
1. Definitions.
Target folder
1. Confidential Information means information concerning inventions, know-how,
ASR type trade secrets and other proprietary Licensor information or information of its
licensars, including Licensor's disclosure of the Licensed Software, Documentation
IP Addresses and trade secrets relating to the Licensed Software and any modifications thereof.
Szrien ATEEn: 2. Fees. means either license fees, royalties or any other compensation required for
the Licensed Configuration of the Licensed Software.
Ready to install 3. Licensed Configuration. means to the extent applicable, as indicated on the
Licenze Key, the choice of features, maximum number of licensed ports, or any
Install progress other specifications, as approved in writing by Licensor.
Finish 4. License Key. means the code provided by Licensor to Licensee, which enables the
W

lirensed Snftware tn anerate in arcordance with the snecified lirensed

5. Select which features you want to include in the installation, and then click Next.

Voca X

Voca

End user license agreement .
Select features to install

Select features
Language selection E‘ Vaca Core (WEB, PLI, DE)
Target folder
[+] wr
ASR type o
IP Addresses [+] asr

Service account
[+] Mrep
Ready to install
Install progress

Finish

o) o) B

6. Select the languages you wish to install, and then click Next.

ﬁ The Spanish dialect is supported in GMM mode only.

-18 -



CHAPTER 3 Installing Voca Voca | Installation Manual

Voca

u Voca

End user license agreement

X

Select languages to install
Select features

Language selection Hebrew
Target folder

ASR type English

IP Addresses German

Service account

Spanish
Ready to install
Install progress

Finish

o] (=) I

7. The Audiologs directory window appears. The Voca system records and saves the speech
request in an audio logs directory. Assign the D:\AudioLogs directory, and then click Next.

Voca

X

Voca

End user license agreement

Voca Audiologs folder
Select features

Language selection AudioLogs Folder: | D:\AudioLogs), O
Target folder

ASR type

IP Addresses

Service account

Ready to install

Install progress

Finish

) (o)

8. From the ASR drop-down list, select the ASR component. As noted above, the Spanish
dialect is supported in GMM mode. Select your choice accordingly, and then click Next.

-19 -
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Veoca X

m Voca

End user license agreement

ASR and DB types
Select features
Language selection ASR Type: DNN ©
Target folder DNN
DB Type:
ASR type GMM

IP Addresses

Service account
Ready to install
Install progress

Finish

o) (oo ) ST

9. If Web Core was selected for installation, you need to select the type of DB:

e Standalone
® Primary
e Secondary
10. Select Primary or Secondary if your installation is part of a High Availability setup.

Voca X

u Voca

End user licenze agreement

ASR and DB types
Select features
Language selection ASR Type: DNN v
Target folder
DB Type: Standalone >

ASR type

Standalone
IP Addresses -

Primary
Service account Secondary
Ready to install

Install progress

Finish

) (o) (D

11. In the 'Traffic IP' field, enter the traffic IP used for SIP; in the '"Web IP' field, enter web IP
used for admin management and the DB.

-20-
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Voca x

u Voca

End user license agreement
Select Voca IP addresses

Select features

Target folder Traffic IP: ‘ 10.31.5.228 v [ Detect ]
ASR type

Web IP: ‘ 10.31.5.228 v
IP Addresses

Service account
Ready to install
Install progress

Finish

o) (o) B

12. During the initial installation, enter a new password for the Voca User. In case of an
upgrade, enter the existing password. Click Next to continue.

Voca X

m Voca

End user license agreement

Voca service account
Select features
Target folder User voca ‘
ASR type
IP Addresses Password [TITIYTY ® ‘
Service account Create user if it doesm't exist
Ready to install

Install progress

Finish

o] o) EEED

13. The Information page appears; click Continue.

-21-
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@ Information

User 'voca” will be created

=

14. On the Ready to Install page, click Install. The installation process begins.

Voca

End user license agreement
Select features

Language selection

Target folder

ASR type

IP Addresses

Service account

Ready to install

Install progress

Finish

Voca

Please review parameters and click Install’ when ready

Install Folder CAMNSCY
Audiologs folder ChAudioLlogs\
Service account voca

|—| MET Framework 4.7.2 Offline

m Microsoft Visual C++ 2010 x86 Redistributable

|7| Microsoft Visual C++ 2013 Redistributable (x86) - 12.0.30501
F‘ Microsoft Visual C++ 2013 Redistributable (x64) - 12.0.30501
m Microsoft Visual C++ 2015 Redistributable (x64) - 14.0.24212
|7| Microsoft Visual C++ 2015 Redistributable (xB6) - 14.0.24212
|7| Woca Prerequisites

e |

Back

] Install

15. The installation progress bar appears.

-22-
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Voca X

Voca

End user license agreement . ) , .
Please wait while we're preparing the system
Select features

Target folder Caching JRE
ASR type _—
IP Addresses

Service account

. Executing NET Framework 4.7.2 Offline
Ready to install
Install progress |

Finish

Cancel

16. When completed, the installer displays the following screen. Click Restart to restart the
server.

Voca x

Voca

End user license agreement i
Voca is ready for use
Select features
Language selection
Target folder
ASR type
IP Addresses
Service account
Ready to install

Install progress

Finish

17. In case of upgrade, change Enghouse services Startup Type to "Automatically".

Provides th... ig...  Local Syste..,
(O Enghouse Interactive Alsrrm Centar Provides a m..  Running Local Syste...
@Enghmlnundi\tﬂl Connect Senver Telephony .. Running MVeca
£ Enghouse Interactive Enterprise Communications Server  Manages all..  Bunning AVoca
‘£ Enghouse Interactive Media Gateway Provides cal... Running MVoca
“ai Enterprize App Management Service Enables ent.. Manual Local Syste...

-23-



CHAPTER 3 Installing Voca Voca | Installation Manual

18. Restart the server.

& Changes will not take effect until you reboot the system.

Running Post-Installation

The procedure below describes how to run the post-installation procedure when performing an
upgrade.
> To run the post-installation when performing an upgrade:
1. Recompile the grammars.
a. Recompile contacts and departments grammars.
b. Recompile the periphery’s grammars.
i. Open the command line as an Administrator.

ii. Run the following commands:

>cd C:\NSC\NSC_AA\<dialect>\Grammars\Compile\compile_dnn\

>CompileGrammars_HB.bat

BE Administrator: Command Prompt

C:\Users\Administrator>cd C:\NSC\NSC_AANEN-US\Grammars\Compile\compile dnn

C:WNSCANSC_AANEN-US\Grammars\Compilelcompile dnn>CompileGrammars_HB.batg

& Version 8.0.1 or later is released with Amazon Corretto Java engine Version
11.0.9.12.1. In case of available security patches for Version 11.x, the installed java
engine can be updated.

2. Reconfigure Music-On-Hold if required.
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3 Voca Upgrade

When upgrading Voca, refer to the upgrade notes described in Installing Voca on page 15.
The following items should be addressed during system upgrade:

B System backup

B LDAP or CSV synchronization migration
M Installing new Voca licenses

B Grammar recompilation

B Setting up Music on Hold

Voca Versions that can be Upgraded

The following Voca versions can be upgraded:
M Version 8.0.0

B Version 8.0.1
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4 Configuring Enghouse Interactive Communication
Portal (CP)

Enghouse Interactive (CP) is a third-party application responsible for SIP connectivity between a
customer's PBX and the Voca speech recognition agent.

> To configure Enghouse Interactive’s CP:

1. Launch the CP Console 10.3.

2. When prompted to set a password, select the 'l don’t want to use...' check box, and then
click OK.

Mew Password: |

Re-type Mew Password: |

Password Strength

3. When the configuration wizard starts, click Next.
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Enghouse Interactive CP Console Configuration Wizard A

Screens that follow will take you through a series of questions which will assist yau in
configuring your CP Domain andjfor Enterprise Communications Server,

Depending on the Enghouse Interactive software components you installed on this
server, different configuration screens will be presented,

Click Mext to continue, or didk Cancel if you want to manually configure the CP Domain
andjor Enterprise Communications Server at a later time,

4. When prompted, enter the password AC123456.

Enterprise Communications Server found

Enterprise Communications Server software has been detected on this server,
Please enter the information needed to connect.

Usernames: | Adrin

Fassword: | |

5. Click Finish when the configuration completes.
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°

The Configuration Wizard is complete. Click Finish to begin using the Enghouse
Interactive CP Consaole,
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5 Installing the Voca License

AudioCodes provides a license to use Voca. You can obtain a "finger print" file from the server
that you want to install Voca on. This file is sent to AudioCodes so that a license file can be
created and sent back to the customer.

ﬁ e Alllicenses have virtual machine clone protection. If there is any change inthe
Virtual MAC address, CPU characteristics or UUID, the license protection
procedure is enabled and you will need to repeat the licensing process.

e After you upgrade to Version 8.0.1 or later, you need to issue and re-install the
Voca new license. Enghouse and TTS software licenses are not affected by the
upgrade.

> To install the Voca License:
1. Login to Voca by navigating to https://<IP Address> in your Chrome browser.

2. To get the Administrator credentials, please contact your AudioCodes representative.

Login to your account

superadmin@vocanom.com

Laein 2)

¥

FOrgot your password?

no worries, o resel your pHEEWGI’d.

& The default Administrator credentials should be modified after installation.
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3. On the Licensing page (Configuration > Licensing), click Get finger print. A finger print file is
created on your server.

Providers . .
Licensing

Services

= Get finger print

dll Reports

Get finger print
Users

Configuration = Set license

Template Settings Choose File | No file chosen

Email Settings

High Availability

= Total licenses

—

Total licenses: 0

Web Access Login Restriction

This is a sample finger print file:

<%?xml wversion="1.0" encoding="UTF-8" %>
<hasp info>

<host fingerprint type="SL-ZdminMode" crc="3221380611">
M¥hISQFckTS 6ChQolNLE Sxgl 2S580a EVMD1HoEmr 2REIUbC EImYANWEUgfI VoG
ThEFIESQCEZnY YalpcMhzat A GFuWbUB2 2T IkuwShGCAYr cBTwaghSCEqh yITMgMB
JEBhiRdQoGtCRIoak0BiFkaBglpoul NYDAMAGHEwliU=</host fingerprint
>

<host fingerprint type="SL-UserMode" vendorid="%4011"
cre="16557180538">
MnhJSYGMDEUOIJUYDWCEL cOgmk FrJpCSbWgMAT 1 peme GADUJIRECZDEILNT J4WT
EqecMAQyFFgoABIEyAVSubFfM] gCpgdQtANuEcTuRGUgBwI GY YNwEWa gwGEvEpAl
OQEENSQAQL 0 TAwygAtbOEaBENADG] t YNAGCuRISM] 4AVE2 QFAHpcEA==</host
_fingerprint>
ffhasp_info}

4. Send the finger print file to AudioCodes.
5. When you have received your License file from AudioCodes, copy it to your server.

6. Click Choose File to select your license.

Providers . .
Licensing

Services

= Get finger print

Reports
Get finger print
Users

Configuration = Set license

Template Settings Choose File | No file chosen

Email Settings

High Availability

= Total licenses

Total licenses: 0

Web Access Login Restriction
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7. Select the license file name, and then click Open.

T ‘ 2 » Administrator » v (_',| ‘ Search Administrator b J
Organize ¥  New folder B - [0 @
W4 Favorites B |
e = N E B E M R K
# Downloads Contacts Desktop Documents  Downloads Favorites Links Music Pictures
£l Recent places
» 0 B
M Thi ‘
P This PC Saved Searches Videos
Games
'h Network
File name: [| v‘ |V2C File (v2c) V|

| Open ‘ ufgncel ‘

8. Inthe Set License window, click Set license to activate your Voca license.

Providers ) )
Licensing

Services

= Get finger print

Reports

Get finger print
= Set license

Template Settings Choose File | No file chosen

Users

Configuration

Set license

= Total licenses

Total licenses: 0

Email Settings

High Availability

Web Access Login Restriction

9. After you have set the license, the total number of licenses should be displayed on the
screen.

Providers

Licensing

= Get finger print

= Set license

Template Settings Choose File | No file chosen

Email Settings

High Availability

Services

Reports

Users

Configuration

=Total licenses

Total licenses: 230

Web Access Login Restriction
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This is an example of what a license file looks like.

k?xml version="1.8" encoding="utf-8"?><hasp_info> <haspscope> <vendor id="94811"> <hasp 1d="182762873689409811" />
</vendor> </haspscope> <v2c>YoIHRKCCBzuABHZ@YzKBggImRi86Bgv++cAwteDkddCYnYgqMAABqIKPE7DABLVINOM1UzGwnd]2Q
SEmXMmIUgITYANAx/1c1xRLxeCO2UBHWC3SBKRFOY1ha9dvT5bZbQYj83JAby /BZSgaDDRhiykbFiLeMahsdy

+EkGAAaUXZuthOeumpzSBAYywY7Ge VMY sXHUYS] /YgHIEYXptnIsksfnFsEBIMITBAvWYudhwHve3 jJFTI5dPUH3gXT+7riQfQxBcNSYIHWZk4Ih8kQI9gUhorki
+YZkGPqxatOWHn5 /vFB80iT+snpZ3/Mss+hwfleBaYaEl3z2Xe9BcEVCRHBCeT2alk+y55QViTMn/HLIjFZi0gmxbgmSR551c5
J6EYFBmI3gzIQXQpK9IBE1F7dAHtkefChgWZR+I0SKsreBa2YbhMghi+npfxBycgmRB7nFebEfMFbL

bMVr29Mx9YVuS8LXFoK/ fvdCXBHEOwGGhunNuICsD3MY 7weSOWZuxnBxIq7+onlR11n91YFCgKek

immlKpIyQaKBVtaeUHDAAmx /w\IbekB5p2DpA/o3EVRTZLW1QGOB1FekPggGlp20Tw3QdUjaSZ71]6sPsAYnsikmSu
+ubsoPLO5tFdPKKQT2NAKBACGaP5+pruwdZXQseb+r88BrUDauggrIelfghidn/rl
TmidKuQF1KItsoKdhueolinl45hXcmzhuEFaOa7MvpvI4FQv3sbqRjRa350UZ@niB4Bd5PSMfloIB
ATUBAYYDAWS7pIIE/IATA01IN3YRjCROBAQSmggSVeAgCill3dhGMIEEKBhIABAaF/gHOxeE1JAVYR
PnoaFCgA@sr3GDV1IKhqRUWOIegGavYAEhRtwomZgA3ApSp8gliigbuEEUgpIAITadiloCluyHNBg
BAAYWSZtQHAIMiS7BKEYICtwFPCqEYS0oDIgyowGM8GG1F1Cgad) EmhoDQGINROGAC Ly 7U1gMCYADETCWI a0CAvaAET FPk1MND5 joqV9aZ
+YTgfuBgglgmEvtDoKvE+vsLashEwgh/K13t05cY41/nwkdXiPydHWSPioWCkzL/+5Hz5ahFQEgztVK2rieiecNzUQzBGs181f j+XMKoz8I4vFI8BNLZEHLZERLT
7rhN3j1VZPne8QdxIk8nu+yjBF6k2nkBAIuCsUgCAuIR2pYCE6FVGIDH1dZX5vkVALir7Xyn+skwpxraus
+udlvsvCpqq26HDD2LdEC2MRRQOk10xYFagMnOYR25VatngqlPxTwtc+5Qnplfwog8NoCDwe3BSBuHiYtobfVNB2FBR24pcMiGEBS1Bd@5uRd6RGCELBE
+eyj70fPqQfiZ9jThuZ885pollbZSsGEtHMI joiMwoYYIBdRS87zaHs I3Milneeol 59F1PMArUQWI gSKrZ+k08GHaEdGL2KyLgjBTU /WwIDd
AIXZ1+ZuxNHKAVChTBQmUF Lihwgeh L FMET iNN7methd b,/ FAwt] qlgZUmxQptg59CA2n1 NVBCKdDyL 8nc
+py8/UsHf3md7DXQUtcn/FPOMEpfBgBlgrnNjhPn9IcYOYHgglgcUxr7ecoFBougKYVaD3

tztnp0qIisXAZUmGgiHd jn/hV16QUopF7K7EYFQCKMtzQ/xVBpanjUVpMscRegNgj85aP99fZGly

COFFKPFnuaA2iPGKACMPws /gwlHSXiIWFMCxEYTERr@y216+LB2gbd3c0/ sYOwxkrVRuideS+2wdrfQzH7 /+czHFr8v2h@xv+0Qt1YTexyyr8ydhgFhWi8zpM
+1eDyCHPvwcCIjFrceYMFqYsC1HtRgpiygKxXeaQFV/HceYOUbbnTI6Z7dYSmkMFiz6Mtg8xKEASMGE15GyUAZuXHvel/YIYneDPKGgS+FLC
588M71iAeMz1BSX/ZPjL10qPwo2zu213Z20T8kIiiunZoiXW2yqMASE+G4LGEBLOS C+Ow+KcI+MF

quel GZDFOjBKX@WFgmPwAPFGowBBDj1JHocBAYgBATqCAQCsv7fMTqC5LmEGzMkdubgsnNPcT6sRbNe8s6AtUTHgKrTChttLtSBvMGYNsDmvo
+mLAF3AHYHTWgrUWHWKIW2AN905X5b91 fagJUBFWVIneGMx351zt2IBbj+9VIYEUypqRegpVWSErsMeDVh7P1N] C+iQxhs245LplW7rHEAS 1cxmdKnBde /S1M
NrKOR/GjCDIMHTPmS IxuFSYor6MTYQ4dIWGIFBFhS@47105p@ T LRIWF x+] /kxgmg5rl7IKacurgB/
VFMeb9t2z4YKGb7+CHBfBD8E2Ho02VX@pzFygMUbbodKpFd301blBanZMu5seFAXUuu9t /AL2t6m
SBeQ/FX2hAELpVGEBYADAWS7oRSAAQSBDOdY YW1 tYXIgVGYZdGVyAKIDgAEAOXUAAQKBFKVUZ21U
ZSBHcmFtblFyIFR1c3R1cgCETABAYELQVNSIEVUZ21uZQChAAABAA==< /v2Cc>< /hasp_info>

After you upgrade to Version 8.0.1 or later, you need to issue and re-install the new
Voca license.

> To install the Voca License after upgrade:
1. Navigate to http://127.0.0.1:1947 on your Chrome browser.

2. Click Sentinel Keys.
Gemalto Sentinel ACC: Sentine x -+

< O @ 127.00.1:1947/_int_/devices.
gemalto”

Options

tml

Sentinel Keys Available on win-7laggajmits

Sentinel Keys # Location Vendor Key ID

Products 1 Local 94011 499444128609102601
Featuras (94011)

Sessions

3. Send the Key ID number for the local server to AudioCodes.

4. When you have received your License file from AudioCodes, copy it to your server and
apply the Voca license using the Voca Web interface (License.htm).
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> To install the Voca License after virtual machine cloning:

' gemalto”

Products Available on WIN-7LAQQAJMLTS
Sentinel Keys # Product Name
Products 1 Voca IVR ASR 2020
Features Disabled due to: Cloning (Hardware Change)
Sessions

1. Clean the cloned license by removing the old V2C file.
a. Stop Sentinel LDK License Manager service.

b. Open C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel
LDK\installed\94011 and remove all V2C files.

c. Start the Sentinel LDK License Manager service.

2. Repeat the license procedure (see Installing the AC Voca License.htm)
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6 Installing Third-Party Licenses

In addition to the previous section that explains how to install the Voca license, you must also
install the Enghouse Interactive license and a relevant Text to Speech license. This section first
describes how to install Enghouse Interactive licenses. Once you have completed this
installation, you must then install and configure an appropriate Text to Speech license.

Installing Enghouse Interactive License

You can install the Enghouse Interactive license. Once this has been installed, you must also
install the Control Panel and CTConnect Media Gateway licenses.
> To install the Enghouse Interactive License:

1. Run the Envox License Utility application from C:\Program Files (x86)\Enghouse Inter-
active\CP\CPLicensingU'tility.exe.

2. Verify your System ID number and send it to AudioCodes.

(o) Enghouse Interactive CP Licensing Utility = =] 22

System Information Mode

System ID: | 3832402690 |

System ID type: | NIC MAC address |
Active license

Enghouse Interactive has two licenses that you need to install:
B Control Panel License

B CTConnect Media Gateway License

Installing Control Panel License

Once you have received your Control Panel license back from AudioCodes, see
Installing Enghouse Interactive License above Paragraph Verify your System ID
number and send it to AudioCodes. above, and continue with the following
procedure.

> To install the Control Panel License:
1. Copy the licenses to C:\NSC\License\.

2. Run the Envox License Utility application from C:\Program Files (x86) \Enghouse Inter-
active\CP\CPLicensingUtility.exe.

3. Onthe Enghouse Interactive CP Licensing Utility screen, click Load license.
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(o} Enghouse Interactive CP Licensing Utility = [ = =
System Information Mode
System ID: [ 3882402690 | —
System ID type: | MNIC MAC address | I"".
Active license
License data
System ID: | 3382402690 |
License type: | Evaluation |
Expiration date: | 3/31/2013 |
User name: | AudioCodes | *
Company name: | AudioCodes | *
*Mandatory fields
Features:
CP Engine Channels
Load license...
Hardware Channels 0
IP Channels 4
Station Channels 0 Appiy |
0

Software Channels

4. Browse to the license file location, and then select the CP_import. XML license file.

Lockc i | L Licerme v| @& i @
= Haire = Date rcdified Type
FL [=€P jimpertami S20PB509AM XML Do
Recent places |
Desitop
Libraries
This PC
% 1:! m | t
Hetwaik
Fibe nawmas: I_ET_IMJI* "l I g ]
Flesoitpe: | Lacerae tios (i com) w| | Cancel |

5. Click Open.

6. On the Enghouse Interactive System Information screen, click Apply License;
a confirmation message box appears informing you that the license has been applied
successfully.

o License applied successfully.

7. Click OK.
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Installing CTConnect Media Gateway License

Once you have received your CTConnect Media Gateway license back from AudioCodes (see
Installing Enghouse Interactive License ), verify your System ID number, and then send it to your
AudioCodes representative. Continue with the following procedure.

> To install the CTConnect Media Gateway License:

1. Copy the Enghouse CTConnect Media Gateway License XML file to
C:\Program Files (x86)\Enghouse Interactive\CTI Connect\Licenses.

File Home | Share  View ~ @
E:i & cut = x =F lu FEd = ig Open HH select an
[ Copy path ol o J - [P Eait 25 Select none
Copy Paste _ Move Copy Delete Rename New Properties i
[3] Paste shorteut | g S 2 folder 5 59 invert selection
Clipboard Organize New Open Select
© A PP oo Files (<86)\Enghouse Interactive\CT] Connectilic IR eI o
o = " .
P Eavorites Name Date modified Type Size
B Desktop [=] importxml  1/7/20207:39 AM XML Document 1KB
& Downloads
“Zl Recent places
1 Temp |
Botna L i
1item =
e s e B = -

A The filename must be named import.xml.
2. Restart the server to complete the license installation.

Installing Text-to-Speech Engine

The following describes how to install the Acapela Text to Speech engine.

Acapela non-Hebrew Text to Speech

e This installation is only applicable for non-Hebrew text to speech.
e Thelicense key is dependent on your server's MAC address.

> To install the Acapela Text-to-Speech license:
1. Verify the server MAC address.

a. Enter "cmd" in the Run dialog box, and then click OK.
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=== Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you,

Open: I crnd| j

B This task will be created with administrative privileges,

014 I Cancel Browse.., |

b. Enter "ipconfig/all".

k Windows" system32'cmd.exe

Microsoft* Windows [Uersion 6.1.76011
Copyright {(c¢> 2B8? Microsoft Corporation. All rights reserved.

C:sUserssAdninistrator>ipconfig ~<all_

2. Find the Intel<R> 82579LM Gigabit Network Adapter, and then send the MAC address
(“Physical Address”) to AudioCodes.

[} Administrator: Command Prompt |;J£-

: Int Ry #2574l Gigabit Hetwork

8-8F-88-B8-91

‘thernet adapter Internal:

: Intel(R> 8 9LM Gigahit Network Connecti

: BR-90-FB-5
= Mo

I(Preferred)

Be-81 -8B -8l -: 3C-3B-47-B0-90-8F-086-B0-92

_____ s = s + &« & 5 10.1.1
18 1
: Ena
1:
_____ c = o« = Media di iected

: Imt (R» 82574L Gigahit Network (

: BR-9@-aF-a68-0@-92 ¥

3. AudioCodes will send you the license key.

4. Open the Windows Start menu, and then in the 'Search’ field, enter "Acapela TTS Server
Control Center”.

5. Select it in the Search results.
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6.

10.

Search

Everywhere

Lﬁcapela TT5S Server Control Cents

Acapela TTS Server Control
ter

On the Acapela TTS Server Control Center screen, click Server configuration.

ﬁ.
B Chient configuration

Dongle update
Utilintses

BB

Acapela TT5 Server Control Center -
SEAVER CONFIGURATION FILE

:': "WProgramData'Acapala Group'Acapela TTS ServerConlacatel_srv conf
(TicPAPPORTS |
Command Fot  |BESE
Data Port  [BEES

§ WY niCuaTC

ey string |

[MaciokEY [ccomy MACID hoense sting here>

LICENSE 5YSTEM

CONFIGLURATION
¥ Display monkoring wandow at starup
[~ Time credt management mode
[ Catch ssrver meceptions
W Catch TTS exoeptions

www acapela-group com

ok | cace | et | b |

Under the License System/Key Device group, select MACIDKEY.

Copy the received license key into the key string field.

Click Apply, and then OK.

Configure the Acapela Telecom TTS Service:

a.

b.

Open Administrative Tools > Services.

Open Acapela Telecom TTS Service Properties.

From the 'Startup type' drop-down list, select Automatic.

Click Start.

Click OK.
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Acapela Telecom TT5 Service Properties (Local Computer) XL
Genera  LogOn Recovery Dependencies

Service name: Acapela Telecom TTS

Dizplay name: Acapela Telecom TTS Service

Description: ’Acapela Telecom TTS server in service mode

Path to executable:
"C:\Program Files (86)"Acapela Group'Acapela TTS Server'\Bin‘acatel_sn

Startup type: HAutomatic e

Service status: Rurining
Start Stop Fause Resume

You can specify the start parameters that apply when you start the service
from here.

Start parameters:

Cancel Aoy
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7 Configuring SBC Settings for Voca

This section describes how to configure the Voca, on the SBC side.
B Coder settings

B Delayed offer SDP settings

B Terminate OPTIONS request
|

Alternate routing settings

Coder Settings

Voca only supports G.711U-law and G.711A-law coders.

These coders should be configured in the Allowed Audio Coder Group in the IP Profile of the
Voca SIP entity on the SBC.

If the PBX system doesn’t support G.711U-law and/or G.711A-law coders, i.e., the coders do
not exist in the SDP offer of the incoming SIP message, the coders should be configured in
Extension Coders Group in the IP Profile of the Voca SIP entity.

Delayed Offer SDP Settings

Voca doesn’t support incoming SIP messages without the SDP offer.

If an incoming SIP message doesn’t have the SDP offer, the 'Remote Delayed Offer Support'
field should be set as Not Supported in the IP Profile of the Voca SIP entity.

For the Remote Delayed Offer Support function, you need to assign extension coders
in the IP Profile of the Voca SIP entity as discussed above.

Terminating SIP OPTIONS Requests

To terminate SIP OPTIONS messages at the SBC device (i.e., to handle them locally), create a
routing rule with the following settings:

Source IP Group: ANY
Request Type: OPTIONS
Destination Type: Dest Address
Destination Address: Internal

Alternative Routing Settings

When Voca does not respond, or responds with a SIP error, create the alternative routing
setting and redirect the call to customer’s extension.
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8 Installing Signed Certificates on the IIS

To configure Voca to work with HTTPS, you must first install a valid signed certificate.

Use the following procedures to install the certificate on the Internet Information Server (IIS).

Managing Certificates in the MMC Snap-in
You can manage certificates in the MMC Snap-in.
> To manage certificates in the MMC Snap-in:

1. Open the Command Prompt window.

2. Enter MMC and then press ENTER.

To view certificates in the local machine store, you must be set up as an
Administrator.

EX Command Prompt - [m] x

3. On the Console Root, click File > Add/Remove Snap.
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ﬁ Consolel - [Console Root]

— m} X
ﬁ File Action View Favorites Window Help |_ X
%= = H
| Console Root Name I Actions
There are no items to show in this view, _
More Actions 3
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4,

5.

6.

From the File menu, choose Add/Remove Snap In.

In the 'Available snap-ins', select Certificates.

Add or Rermove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For

extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins:

Snap-n Vendeor

=" ActiveX Control Microsoft Cor...
Auﬁ'mrizah’on Manager Microsoft Cor...
I:-i_ll Microsoft Cor...
oy Component Services  Microsoft Cor...
;{'JComputer Managem... Microsoft Cor...
HDevice Manager Microsoft Cor...
= Disk Management Microsoft and...
@ Event Viewer Microsoft Cor...
I Folder Microsoft Cor...
_§J Group Policy Object ... Microsoft Cor...
g IP Security Manitor Microsoft Cor...
@ IP Security Policy M...  Microsoft Cor...
= Link to Web Address  Microsoft Cer...
- ‘e - - P

Description:

Add =

Selected snap-ins:

] console Root

Edit Extensions. ..

Remove

Move Up

Move Down

Advanced...

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.,

Cancel

Click Add > to add snap-ins.
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7. Inthe Certificates snap-in group, click the Computer Account option, and then click Next.

Certificates snap-in >

Thiz snap-n will always manage cerificates for:

() by user account

() Service accourt

< Back Mext > Cancel

You can select either My user account or Service account options. If you are not
an Administrator of the computer, you can manage certificates only for your user
account.

8. Click the Local computer option.

Select Computer *

Select the computer you want this snap-4n to manage.

This snap-in will always manage:

(®) L ocal computer: fthe computer this consale is running onj

() Another computer: Erowse...

[] Mlow the selected computer to be changed when launching from the command line. This
only applies f you save the console.

< Back Cancel

9. Inthe Select Computer dialog box, click Finish.

10. In the Add/Remove Snap-in dialog box, click OK.

-44 -



CHAPTER 8 Installing Signed Certificates on the IIS Voca | Installation Manual

11. Inthe Console Root window, click Certificates (Local Computer) to view the certificate
stores for the computer.

ﬁ Console! - [Console Roof\Certificates (Local Computer]] - n] X
ﬁ File Action View Favorites Window Help -8 X
LL I ol ]l

[ Console Root Logical Store Name Actions

) ﬁ Certificates (Local Computer) T Personal Certficates (Local Computer) a

[ Trusted Root Cerification Authorities

. More Actions )
] Enterprise Trust
" Intermediate Certfication Authorities Preview Build Roots A
[ Tusted Publishers More Adtions )

[ Untrusted Certficates

"I Third-Party Roat Certfication Authorities
[ Trusted People

] Client Authentication ssuers

1 Preview Build Roots

(21 AAD Token lssuer

"I Homegroup Machine Certficates
| Remote Deskiop

[ Smart Card Trusted Roots
sms

[Hsee

[ Trusted Devices

[ Windows Live D Token ssuer

Preview Build Roots store contains 1 certficate.

12. To view certificates for your account, repeat steps 3 to 6. In step 7, instead of selecting
Computer account, click My User account and repeat steps 8 to 10 (Optional step).

13. From the File menu, choose Save or Save As. Save the console file for later reuse (Optional
step).

Adding a Certificate

1. Navigate to Console Root > Certificates (Local Computer) > Personal > Certificates.
2. Onright pane, select All Tasks > Import.

3. Follow the dialog to install the certificate.

Selecting a Certificate in I1IS Manager

You can select a certificate in the Internet Information Services (lIS) Manager.

> To select a certificate in 1IS Manager:

1. Open the lIS Manager.
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A Dok i e :;3 “/ Yy “ i3 \) % % [ Basc Settings
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2. Right-click the default site, and then choose Edit Site — Bindings.

3. Select HTTPS binding (Port 443), and then click Edit.

Edit Site
R PR . T - Bindings...
&tﬁ : ﬁi Basic Settings...

Directory i Tunes | h|fi w Applications
Browsing Site Bindings @—23 W Virtual Director
[

N .
QEditSibe Binding (2] = | |Je Web Site
S5L Se Start
Type: IP address: Port: rt
[ https = | All Unassigned - 443 P
[ R ] Web Site
Host name:
| | Browse se %80 (http)
se 443 (https)
S5L certificate: ]
anced Settings...
[AcVocaLocal <[ view.. | —

nits...

[ ok |[ canca | tall Application Fi
Gallery
. ’ 0 Help

4. From the 'SSL certificate' drop-down list, select the new certificate, and then click OK.
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9 Enabling .NET Framework 3.5 on Windows

You can use Server Manager to enable .NET Framework 3.5. For more information, see
Microsoft’s guidelines here.

Before enabling .NET Framework 3.5, ensure that you have the following:
M Windows Server 2016

B Administrator user rights. The current user must be a member of the local Administrators
group to add or remove Windows features.

M Target computers might need network access and rights to use either alternate sources or
an Internet connection to use Windows Update.

B Installation media (only if you have no Internet connection to use Windows Update)

> To enable .NET Framework 3.5 on a Windows System:

1. Onthe Server Manager page, click Manage, and then select Add Roles and Features to
start the Add Roles and Features Wizard.

[ Server Manager - |oixn

S DaShbDard v ':E‘:' | [’ Manage Tools View

Add Roles and Features I

Remaove Roles and Features

|'_' Dashboard WELCOME TO SERVER MANAGER
- Add Servers

0 Local Server Create Server Group
ii All Servers ' i
- - o i CO r-nCl q ure Server Manager Properties -

2. Onthe Before you Begin page, click Next.
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DESTINATION SERVER

Before Yyou beg in WIN-6LFOS6T2BAT

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
Installation Type hosting a website,

Server Selection

To remove roles, role services, or features:
Server Roles Start the Remove Roles and Features Wizard

Reatiies Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* MNetweork settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again,

To continue, click Next.

[] Skip this page by default

|<Previous|| MNext > | | Install || Cancel |

3. On the Select Installation Type page, click the Role-based or feature-based installation
option, and then click Next.

DESTINATION SERVER

Select installation type WIN.5LF056728A7
Before You Begin Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual kard disk (VHD).

(® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

Server Selection

Server Roles

) Remote Desktop Services installati
Install required role services for Virtual Desktop Infrastructure (VD) to create a virtual machine-based
or session-based desktop deployment.

Features

[<Previous | [ New> | | insal || Cancel |

4. On the Selection Destination Server page, select the target server, and then click Next.
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DESTIMATION SERVER

Select destination server WIN-6LFOS6T28AT

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installation Type ®) Select a server from the server pool
O Select a virtual hard disk

Server Roles Server Pool

Features

Filter:

Name IP Address Operating System

WIN-6LFO5672BAT 312, Microsoft Windows Server 2012

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collaction is still incomplete are not shown.

[ <Previous | [ Nedt> | | nstal |[ Cancel

5. On the Select Server Roles page, click Next.

DESTINATION SERVER

Select server roles WIN 6LFOS6728A7

Select one or more rales to install on the selected server,

Before You Begin

Installation Type Roles Description
Server seecton Directory Certificate Services il ;cgvgsf:ﬁ::;ytgir::;?e SeRiices
[ Active Directory Domain Services certification authorities and related
Features [] Active Directory Federation Services role services that allow you to issue
[[] Active Directory Lightweight Directory Services :::ega;g:;?;?xfs usedlina
[] Active Directory Rights Management Services
[] Application Server s
[] DHCP Server
[] DMS Server
[ Fax Server
b [®] File and Storage Services (1 of 12 installed)
[ Hyper-v
[[] Network Policy and Access Services o
[] Print and Document Services
[] Remate Access
[[] Remote Desktop Services ™
| <Previous | [ Net> | | nstal || cancel |

6. On the Select Features page, select the '.Net Framework 3.5 Features' check box, and then
click Next.
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= Add Roles and Features Wizard = 9

DESTIMATIOM SERVER

Select features WIN-6LFOS572BAT

Before You Begin Select one or more features to install on the selected server.

Installation Type Features Description
Server Selection _ ~ NET Framework 3.5 combines the
Server Roles P BN it vk ead Mies power of the .NET Framework 2.0
e b [m] .MET Framework 4.5 Features (2 of 7 installed) APIs with new technolagies for
I [] Background Intelligent Transfer Service (BITS) = building applications that offer
Confirmation [[] BitLocker Drive Encryption appealing user interfaces, lprote.ct
. your customers' personal identity
[ Bitlocker Network Unlock infermation, enable seamless and
[ BranchCache secure communication, and provide
[ Client for NFS the ability to model a range of
o business processes.
[] Data Center Bridging
[] Direct Play

[] Enhanced Storage

[] Failover Clustering

[] Group Policy Management
[] 115 Hostable Web Care

[] Ink and Handwriting Services

— - W

< m >

| < Previous | | Mext = Install

7. On the Confirm Installation Selections page, click Install.

& On the Confirm Installation Selections page, a warning is displayed asking Do you
need to specify an alternate source path?. If the target computer does not have
access to Windows Update, click the Specify an alternate source path link to spe-
cify the path to the \sources\sxs folder on the installation media and then click OK.
After you have specified the alternate source, or if the target computer has access to
Windows Update, click the X next to the warning, and then click Install.
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. . . DESTINATION SERVER
Confirm installation selections WIN. 61705672347
| A Do you nead to specify an alternate source path? One or more installation selections are missing source files on the destinati... x

Before You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type [[] Restart the destination server automatically if required
Server Salection Optional features (such as administration tocls) might be displayed on this page because they have
| been selected automatically. If you do not want to install these optional features, click Previous to clear
S (el = their check boxes.
Features

.MET Framewark 3.5 Features
NET Framework 3.5 (includes .MET 2.0 and 3.0)

Export configuration settings
Specify an alternate source path

<Previous | | Nec> | [ sl | [ Cancel
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10 Configuring WebRTC

WebRTC is an AudioCodes SBC feature and allows up to three concurrent WebRTC sessions, as
part of the AudioCodes SBC license.
For support of more sessions, contact your AudioCodes representative.

For more information, you can download the following:

B Mediant Software SBC User's Manual

B Adding Click-to-Call Widget to an Existing Web Page (video)

-52-


https://techdocs.audiocodes.com/session-border-controller-sbc/mediant-software-sbc/user-manual/version-740/Default.htm
https://techdocs.audiocodes.com/ac-voca/ppt-add-widget/AudioCodes-WebRTC-click-to-call-deployment-procedure.wmv

CHAPTER 10 Configuring WebRTC Voca | Installation Manual

This page is intentionally left blank.

-53-



International Headquarters
1 Hayarden Street,

Airport City

Lod 7019900, Israel

Tel: +972-3-976-4000

Fax: +972-3-976-4040

AudioCodes Inc.

200 Cottontail Lane
Suite A101E
Somerset NJ 08873
Tel: +1-732-469-0880

Fax: +1-732-469-2298

Contact us: https://www.audiocodes.com/corporate/offices-worldwide

Website: https://www.audiocodes.com/

Documentation Feedback: https://online.audiocodes.com/documentation-
feedback

©2021 AudioCodes Ltd. All rights reserved. AudioCodes, AC, HD VolP, HD VolP Sounds Better, IPmedia,
Mediant, MediaPack, What's Inside Matters, OSN, SmartTAP, User Management Pack, VMAS, VolPer-
fect, VolPerfectHD, Your Gateway To VolP, 3GX, VocaNom, AudioCodes One Voice, AudioCodes Meeting
Insights, AudioCodes Room Experience and CloudBond are trademarks or registered trademarks of Audi-
oCodes Limited. All other products or trademarks are property of their respective owners. Product spe-
cifications are subject to change without notice.

Document #: LTRT-23729

QC audiocodes



http://https//www.audiocodes.com/corporate/offices-worldwide
http://https//www.audiocodes.com/
https://online.audiocodes.com/documentation-feedback
https://online.audiocodes.com/documentation-feedback

	Installation Manual
	Notices
	WEEE EU Directive
	Customer Support
	Documentation Feedback
	Related Documentation
	Document Revision Record
	Software Revision Record

	1    Introduction
	2    Getting Started
	Hardware Requirements and System Capacities
	Hardware Requirements
	On-premises Installation
	Private Cloud Installations

	System Capacities

	Entries Support
	Using Clean Windows Installation
	Additional Software Installation
	Disabling Virtual Memory Paging File

	Using AudioCodes Mediant 800 Installation
	Installing Windows Security Updates
	Configuring the OSN IP Address


	3    Installing Voca
	Running Post-Installation

	3    Voca Upgrade
	Voca Versions that can be Upgraded

	4    Configuring Enghouse Interactive Communication Portal (CP)
	5    Installing the Voca License
	6    Installing Third-Party Licenses
	Installing Enghouse Interactive License
	Installing Control Panel License
	Installing CTConnect Media Gateway License

	Installing Text-to-Speech Engine
	Acapela non-Hebrew Text to Speech


	7    Configuring SBC Settings for Voca
	Coder Settings
	Delayed Offer SDP Settings
	Terminating SIP OPTIONS Requests
	Alternative Routing Settings

	8    Installing Signed Certificates on the IIS
	Managing Certificates in the MMC Snap-in
	Adding a Certificate
	Selecting a Certificate in IIS Manager

	9    Enabling .NET Framework 3.5 on Windows
	10    Configuring WebRTC


